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Introduction

1
Welcome to FirstClass, SoftArc’s electronic mail, conferencing, and on-line system. This 
guide will help you install the FirstClass Client software on your Macintosh and then 
show you how to connect to a FirstClass server and start using all of the great features 
FirstClass offers.
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About FirstClass 
FirstClass is SoftArc’s electronic communication system for Macintosh computers. 

FirstClass is an advanced conferencing, electronic mail, bulletin board, and online communication 
system that combines superb communications with a graphical user interface. Using FirstClass, the 
graphical user interface makes sending messages and transferring files easy and quick. In addition, 
the same interface takes care of all modem and file transfer protocols automatically, so remote 
access is just as easy as network access.

With FirstClass you can...

Exchange electronic mail with other users.

Exchange mail with users on other systems such as the 
Internet.

Transfer any number of files quickly using file attachments.

Engage in electronic conferencing with other users on a 
variety of topics.

Dial in using a modem while retaining the full graphical 
interface of your Macintosh.

Engage in a chat with other users online.

FirstClass was designed for computers with a graphical user interface. This means that you can find 
what you are interested in quickly, without sifting through reams of unwanted information. You can 
point and click to read a particular message or open a conference without having to sort manually 
through all the messages on a particular topic.
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Nothing in FirstClass forces you to wait; you can read a message in one window, browse a 
conference in another, compose a memo in a third, and chat with another user in yet another window, 
all while transferring a file in the background. FirstClass provides the ideal environment for online 
electronic communications.

The Server and the Client
FirstClass actually consists of two pieces of software: The FirstClass Server and the FirstClass Client. 
The Server is run by your System Administrator; you will be running the FirstClass Client application 
in order to access the services provided by the FirstClass Server. Note that the FirstClass Client 
requires a FirstClass Server to connect to. You cannot use any of the features of FirstClass unless 
you are actually connected to a FirstClass Server. The client may be connected to the server using a 
number of communication systems, including modems, AppleTalk, Ethernet, and serial cables.

Since this manual is for the FirstClass Client software, when we say “FirstClass” in the manual we will 
mean the FirstClass Client.

Before You Start
You should have some familiarity with the Macintosh graphical user interface before using FirstClass. 
You should understand terms such as mouse, drag, open, select, file, choose and double-click. For 
more information, refer to the manuals that came with your computer.

How to use this Guide
This guide is designed to get you up and running quickly. It covers the installation and basic operation 
of FirstClass. If you have already used FirstClass, or you are an experienced Macintosh user, much 
of FirstClass will be familiar. In this case you might find it easiest to skim this guide and read up on 
the more advanced features of FirstClass, which are covered in the FirstClass Client User Manual.
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Documentation Conventions
Throughout this document, there are several conventions that you should be aware of: The names of 
applications will be referred to using italics, e.g. the FirstClass Client 2.5 application. Folders and 
conferences are referred to using quotations, e.g. the “FirstClass Client” folder or the “News” 
conference. Entries on forms are referred to as fields or boxes and are denoted using the Geneva 
italic type face, e.g. the Server name field on the Communication Setup. Buttons and menu items are 
referred to in italics, e.g. the File menu, the Setup button.

Finally, some information in this manual appears in more than one place. In this case, there will be a 
note referring you to the other section, and the reference will be denoted by the chevron character 
(»).

Support
Your Administrator should be able to solve any problems you encounter. Once you have installed 
FirstClass and have connected to the server, you may use the mail system to request assistance or 
report any problems by addressing messages to Administrator. If you are unable to install FirstClass, 
you will have to use another method (e.g. phone, fax) to contact your Administrator.

In addition, SoftArc Inc. runs its own FirstClass system, SoftArc On Line, for customer support. The 
system is available twenty-four hours a day for any user to log in and auto-register. Our conferences 
answer commonly-asked questions and contain many hints and tips from experienced FirstClass 
users. The number for SoftArc Online is (416) 609-2250. You can log in as User ID “guest” with no 
password if you would like to try out the system or ask questions in public areas. Auto-registration is 
available so you can log in as yourself using your favorite User ID and password if you plan to call 
more than once.

We also provide support through several other electronic mail systems:

Internet
You may contact us as support@softarc.com or sales@softarc.com. We also have our own 
newsgroup, alt.bbs.first-class.
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America Online
Out account is SOFTARC. We monitor American Online and also provide support through the 
Communications And Networking area.

Compuserve
Our account is 70511,2023. We also monitor MACCOMM and IBMBBS.

AppleLink
CDA0674
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Installing FirstClass

2
The first step in using FirstClass is to install the software onto your Macintosh. 
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What You Need
FirstClass may be installed on almost any Macintosh. The requirements are:

• A Macintosh Plus or newer Macintosh computer.
(Avoid the 128, 512, and 512e models.)

• System Software 6.0.3 or later
FirstClass is fully System 7 compatible.

• At least 1 megabyte of free storage on your hard disk.
(To check this, open any folder on your Macintosh and choose By Icon from the View menu. The 
amount of available storage is shown in the upper right corner of the folder.)

• 600K or more of free memory after starting your Macintosh.
(To check this, choose About This Macintosh... from the Apple menu. The free memory is 
displayed in the Largest Unused Block field.)

Installing FirstClass
To install FirstClass, simply insert the FirstClass Client diskette into your Macintosh and drag the 
“FirstClass Client” folder to the appropriate folder on your hard disk. This will create a copy of the 
“FirstClass Client” folder on your hard disk. The “FirstClass Client” folder contains all of the files 
required by FirstClass.

The installation FirstClass Client diskette may include a “Read Me file”, which will include installation 
notices and late breaking news. Please read this file (if it exists) for changes to the installation 
procedures.
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Settings Files
Typically, every FirstClass system you will connect to has an Settings File. A Settings File contains all 
of the information required for FirstClass to connect to a server. For example, if the connection will be 
made via modem the Settings File will typically contain the phone number of the system. If the 
connection is to be made over an AppleTalk network, the Settings File typically contains the server 
Name and Zone. The Settings File may also contain additional custom items such as forms, icons, 
sounds and pictures.

Usually, your Administrator will have provided a Settings File for you to use when connecting to the 
FirstClass Server. To find the Settings File, simply open the “Settings” folder, stored in the “FirstClass 
Client” folder:

 

If there is not a Settings File for the Server you want, you may also create new Settings Files, 
although they will lack any custom forms, etc. To create a new Settings File, simply duplicate the 
“Generic” settings file and rename it as required

Starting the FirstClass Application
To start the FirstClass Client application, simply open a Settings File by double-clicking on it. As soon 
as FirstClass starts up, the Login Form is displayed:
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From here, you login, or connect, to the FirstClass Server. The Login Form has the following boxes 
and buttons:

User ID
Each user has a unique and private User ID. You should type your User ID into this box. If 
you do not have a User ID, you should check with your System Administrator. » By using the 
Setup button, you may also store your User ID in the Settings File for convenience. » Your 
Administrator may have enabled the Auto-register feature, which will allow you to log in with 
any User ID. See the Auto registering  section of the FirstClass Client User Manual.

Password
Each user has a unique and private password. You should type your password into this box. 
If you have forgotten your password, you should check with your System Administrator. » By 
using the Setup button, you may also store your User ID in the Settings File for convenience. 
» For details on changing your password, see the section entitled Changing Your Password  
in the FirstClass Client User Manual for details.

Service
This field shows you the name of the Settings File you have open.

Setup button
Clicking on the Setup button allows you to change the Settings File.

Cancel button
Clicking on the Cancel button will close the Login Form.

Login button
Clicking on the Login button will instruct FirstClass to start a connection to the FirstClass 
Server, using the current settings.

In this example, we have entered the User ID and password into the appropriate boxes.
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Checking The Settings File
The first time you use a Settings File you should ensure that all of the settings are correct. By clicking 
on the Setup button on the Login Form or by choosing Setup... from the Service menu the Settings 
Form is displayed:

The Settings Form will have the name of the Settings File displayed in the title, and will also contain 
fields for entering and setting additional items:

Connect Via
The Connect Via popup allows you to choose which method you will use to connect to the 
server. Typically you will choose either AppleTalk or Modem. For details on additional choices, 
see the FirstClass Client User Manual.

Setup button
Clicking on the Setup button will display the Connection Setup Form for the connection type 
selected in the Connect Via popup. » For details, see the Connection Setup chapter.

User ID
You may enter your User ID here to have it automatically stored in the Settings File.

Password
You may enter your password here to have it automatically stored in the Settings File. Note 
that this is a potential security violation, since it will allows anyone who has access to your 
computer to log into your account.
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Logon Automatically

If this is checked, FirstClass will automatically log on as soon as the Settings File is opened. 
» You may disable the automatic logon by holding down the Option key when you open a 
settings file.

Retry, Retry Delay
If you will be connecting via modem and you receive frequent busy signals, you may 
configure FirstClass to retry automatically. For more details see the Automatic Redial section 
in the FirstClass Client User Manual.

Server, Network
If you will be connecting to the server over an AppleTalk network, you should enter the server 
name in the Server box and the server zone in the Network box. » For more details see the 
AppleTalk Network Connections section in the FirstClass Client User Manual.

Phone Number
If you will be connecting to the server over a modem, you should enter the server phone 
number in this box. If you are connected to an office phone system, you may have to enter a 
“9” (or other special dialing prefix) followed by a comma to dial out correctly. » For more 
details see the Modem Connections section in the FirstClass Client User Manual.

Cancel button
Clicking on the Cancel button will discard all changes you have made to the Settings File.

Save button
Clicking on the Save button will save the Settings Form into the current Settings File.

Note: If other people have access to your computer, you may prefer not to save your UserID or 
Password information for security reasons. If you chose not to save this information, you can 
simply type them into the box on the Login Form every time you open the settings file.
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Running FirstClass Over A Modem

3
If you will be using a modem with FirstClass to connect to an online system, you should 
read this chapter.
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Before You Start

Note: If you will not be using modem connections you may skip this chapter.

Before you start using FirstClass with a modem, you should ensure that you have set up FirstClass 
and your Macintosh so that they will work together correctly with your particular modem. Follow these 
steps (in this example, we will configure FirstClass to work with a Hayes Optima 14.4 modem):

1) Ensure that you have connected your modem to your Macintosh as specified in the modem 
documentation. We suggest that you use an approved Hardware Handshaking Cable.

2) Double-click on the FirstClass Client application. A dialog box will appear asking you to select 
a settings file. Click on the Cancel button:

3) Choose Modem from the Connection Setup sub-menu in the Service menu:
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4) The Connection Setup Form will be displayed:

 

5) Use the Modem popup to select the type of modem that you have. In this example, we’ll 
choose Hayes Ultra. If your modem does not appear in the popup, you should select Hayes 
2400, Hayes 9600, or Hayes 14400, depending on the speed of your modem.

6) If you have the modem connected to the Modem connector on your Macintosh, set the Port 
popup to Modem Port. If you have the modem connected to the Printer port set the Port popup 
to Printer Port. 

7) Set the Phone popup based on the type of phone line that you have (Pulse if you have dial 
phones, Tone if you have Touch Tone phones).

8) Click on the Save button. This will save your FirstClass modem settings.

19



20

» If you want additional information about the Connection Setup Form, see the section entitled The 
Connection Setup Form in the FirstClass Client Users Manual.

Checking The Settings File
Here is an example of how a Settings File might look if it was configured for modem access. Note that 
the Connect via popup has been set to Modem, and that the phone number of the server has been 
entered. Remember, if you are using an office phone system you might have to place a “9” before the 
number, and you might have to add or remove the area code as appropriate.

Logging In to a FirstClass Server using a Modem
Once you have started the FirstClass application by double-clicking on a Settings File and entered 
your User ID and Password, you still have to connect, or log in, to the FirstClass server. To do this, 
click on the Login button. FirstClass will use the connection information stored in the Setting File to 
connect to the server.
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The steps required for FirstClass to connect to a server using a modem are more complex than when 
using a network connection, but since FirstClass takes care of automating the steps the login process 
is straight forward. As each step of the process is performed, you will be informed by the two status 
lines on the Login Form:

All modems work in a similar manner: FirstClass sends a command to the modem, which then 
processes the command and responds to FirstClass with either an “OK” (if the command was 
successful) or an “ERROR” (if the command was not successful). If FirstClass receives no response 
at all after three seconds, it will attempt to get the modem’s attention and will display “Getting 
modem’s attention” in the status line. If there is still no response from the modem, the login will fail 
and error 1034 (“There is no response from the modem”) will be displayed. If this happens, see the 
section in the Troubleshooting chapter entitled No Response From Modem.

When you click on the login button, the following actions occur (note that if any step fails, the entire 
login will be stopped):

1) FirstClass uses the specified serial port (Modem or Printer) to try and reset to the modem. It 
sends the modem the reset command and waits for an “OK” response from the modem.
Status Line display: “Resetting modem” followed by the command sent to the modem.

4) If the modem is reset correctly in step 1, FirstClass then sends the setup to the modem. 
Since each modem requires a different setup, it is important that you have set the modem 
type correctly.
Status line display: “Setting up modem”

5) Once the modem has been set up, FirstClass sends additional commands to configure the 
modem options (e.g. speaker on or off, etc.).
Status line display: “Sending modem options”
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6) FirstClass then tells the modem to dial the number stored in the Settings File. You should 
ensure that the number displayed in the status line is correct.
Status line display: “Dialing. the number”

6) While the modem is dialing, FirstClass waits from a response from the modem.
Status line display: “Waiting for connection” followed by the actual dialing command sent to 
the modem.

Once the modem has started dialing the server, there are a number of possible outcomes:

1) If everything is successful, the server will answer the call and the two modems will connect. 
In this case the status line will display the message “Negotiating connection” and then the 
“Connected” message.

2) If the server modems are all busy, the modem will report “BUSY” and the status line will 
display “Line is busy”.

If the connection fails for any other reason, refer to the Modem Connections section in the 
Troubleshooting chapter of the FirstClass Client User Manual.
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Running FirstClass Over A Network

4
If you will be using an AppleTalk network to connect to the FirstClass server you should 
read this chapter..
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Before You Start

Note: If you will not be using AppleTalk network connections you may skip this section.

Before you start using FirstClass to connect to a server over an AppleTalk network, you should 
ensure that you have set up FirstClass and your Macintosh so that they will work together correctly. If 
you will be using an AppleTalk network to connect to your server, you should ensure that your 
Macintosh is connected to the AppleTalk network and that AppleTalk is turned on. To check this, open 
the Chooser (in the Apple menu). Ensure that the Active button is pressed:
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Checking The Settings File
Here is an example of how a Settings File might look if it was configured for network access. Note 
that the Connect via popup has been set to AppleTalk, and that the server Name and Zone have been 
entered.

Logging In to a FirstClass Server
Once you have started the FirstClass application by double-clicking on a Settings File and entered 
your User ID and Password, you still have to connect, or log in, to the FirstClass server. To do this, 
click on the Login button. FirstClass will use the connection information stored in the Setting File to 
connect to the server. After a brief negotiation your FirstClass Desktop will be displayed.

If you receive error 1044 (“There is no FirstClass server with that name on the network”), then you will 
have to ensure that the server Name and network Zone settings are set correctly. If the Name and 
Zone are set correctly, or if you receive any other error, contact your administrator to ensure that the 
server is running.
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The FirstClass Desktop

5
The FirstClass Desktop is your starting point for accessing the services provided by 
FirstClass. 
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The Desktop
Once the login has completed, your FirstClass Desktop will be displayed. The standard FirstClass 
desktop looks like this, although your Administrator might have customized it:

The Desktop window is always displayed while you are connected to the FirstClass Server. The 
following important icons are displayed on your desktop:

Mailbox: Your mailbox is where all of your incoming and 
outgoing messages are stored. » For details on sending and 
receiving mail see the Using Electronic Mail section. 

News: The “News” conference is a public area that everyone 
on FirstClass has access to.. » For details on using “News” and 
other conferences, conferences, see the Using Conferences 
section.

Conferences: The “Conferences” folder usually contains all 
of the conferences that you have access to. You Administrator 
will set up a variety of public and private conferences.

Help: The Help folder contains a complete online help system 
that will give you more information about your FirstClass 
system. 

Each of these icons represents a folder, which in turn may contain additional files, folders, and 
messages. To open an icon, simply double-click on it (or click once and choose Open from the File 
menu).
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Unread Flags
To help you keep track of what you have read, FirstClass will display a small flag (like this  ) beside 
any conference that contains items that you have not read. In the example Desktop above, both the 
Mailbox and the “News” conference contain items that you have not read. Once you have read all 
items in a conference or your Mailbox, the Unread Flag will be turned off.

Palette
FirstClass provides a Command Palette for quick and easy access 
to many FirstClass messaging commands. To display the 
Command Palette, choose Palette from the View menu. You will 
see references to the palette buttons throughout this guide.
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Using Electronic Mail

6
The FirstClass electronic mail system allows you to send messages and files to any other 
users on FirstClass.
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Reading Your Mail
When you open your mailbox by double-clicking on the mailbox icon on your desktop, a message 
summary is displayed. Remember, you know immediately if you have new unread messages because 
an Unread Flag will be displayed beside the MailBox icon.

Your mailbox contains both your incoming and outgoing private messages: 

The summary lists the sender or recipient of the message, the size, the subject, and the date the 
message was sent or received.

The following indicators are used to draw attention to certain messages:

A solid flag indicates that the message is unread, meaning that you have not yet 
opened this message.

A hollow flag indicates that the message is unsent, meaning that you have created the 
message, but not yet sent it.

A file icon indicates that the message has one or more files attached to it. » See the 
chapter entitled File Attachments and Transfers for more details.

bold Bold type indicates that the message is urgent.

To open any message, simply double-click on it. The message is displayed in a new window:
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Note that the window is divided into two panels. The upper panel contains the envelope information 
(such as the sender’s name, a list of recipients, the time and date of sending, etc.). The lower panel 
contains the content of the message. Separate panels enable you to scroll the message and the 
envelope independently of each other, which is useful when the envelope is very long.

To adjust the split bar between the panels, drag it with the mouse: 
position the cursor over the split bar, and when
the cursor changes to the one above, drag the split bar up or down .

To close the message window, click on its close box in the upper left corner.
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Opening the Next Unread Message
Usually, you will want to read all of your unread messages. To make this more convenient, FirstClass 
provides a shortcut to do this: simply open your MailBox and then choose Open Unread from the 
Conference menu. FirstClass will open the next unread message in your MailBox. Continuing to 
choose this menu items will read all unread messages. When there are no more unread messages, 
FirstClass will sound the System Alert Sound to inform you.

Hint: If you resize the message window, subsequent messages will be opened using that size and 
location.

Since this is a common operation, you might also find it convenient to use either the keyboard 

equivalent (Command-U) or the palette button:   

Composing and Sending Mail
In addition to reading mail sent to you, you may also compose and send your own messages. Follow 
these steps:

1) Choose Compose from the Message menu. A new, unsent message is created in your 
MailBox and the following message window appears. Note that your name is automatically 
entered in the From field:

2) Type a subject for the message and press enter. The cursor moves to the To field, ready for 
you to address the message.

3) Type the name of the person you are sending the message to into the To field. When you 
press enter or tab, FirstClass searches for the name in its User Directory.
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You can enter a complete name such as “Sue Bram”; a last name only, such as “Chun”; or 
even a first name, like “Bill”. If only a single matching name is found in the User Directory, the 
full name replaces whatever you have typed.

 

If more than one name is found, FirstClass displays a list of all the names that match:
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To choose a name from the list and enter it into the address list, scroll through the list until 
you see the name you want and then double-click on it. You may also select one or more 
names then click on the Select button. 

Note: After you’ve entered a name, pressing the enter key creates a new line for entry of another 
name. Pressing the tab or down arrow key will position you at the next field without creating 
space for another name.

4) Enter names in the Cc: field if you wish to send copies of the message to additional users.

5) Enter the content of the message by clicking the mouse in the lower portion of the message 
window and typing.

6) If you are ready to send the message, choose Send from the Message menu. If you close the 
message without sending it, FirstClass gives you the option to send it:

Click the Send Now button to send immediately. If you don’t want to send the message 
(perhaps you want to work on the message later), click the Don’t Send button. The message 
will be kept in your mailbox with an unsent flag beside it to remind you that it has not yet been 
sent. Clicking the Cancel button returns you to the message.

When a message is sent, a Postmark is automatically put on 
the top right portion of the message. The postmark indicates 
that the server has received the message and has begun 
delivery to the recipients.

If you realize that your message wasn’t quite finished and wish to retrieve it for further editing, choose 
Unsend from the Message menu. The message is removed from all recipients’ mailboxes and the 
Unsent Flag is turned back on in your MailBox.
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Editing Messages
Whenever you create a new message you will use the FirstClass editor to edit the message body. 
The FirstClass editor provides a full-screen WYSIWYG (what-you-see-is-what-you-get) interface that 
supports all the standard editor functions (Cut, Copy, Clear, Paste). Double-clicking in the editor will 
select a word; triple-clicking will select a paragraph. Choosing Select All from the Edit menu will select 
the entire body.

You can use styles, colors, and fonts in any message. The FirstClass editor supports:

• Styled text (including italics and bolding).
• Multiple fonts.
• Different sizes.
• Colored text.
• Command key equivalents for common styles and colors.
• Tabs

Once you have entered your message, you can select text and change it by choosing either the Font, 
Size, Style, or Color sub-menus from the Edit menu, and then choosing the appropriate item.

Remember that fonts are installed in each Macintosh. If you use custom fonts, the receiver must have 
the same fonts installed in order to see them. If FirstClass cannot find the font, it will use a default 
font. In order to avoid this problem, you may wish to use the standard system fonts (Geneva, 
Monaco, Courier, Helvetica and Times are fonts installed on most systems).

Note: Not all FirstClass Client applications are able to display styled and colored text. On some 
platforms (e.g. DOS, Windows, Newton) all text is displayed in a single color and style. You 
should be careful while composing your message that it will be readable even in plain text.

While editing in FirstClass, your text is saved to the server as you type. If there is a problem (such as 
a communications failure with your server or a power failure), the message will preserved in your 
MailBox on the server, and ready to send when you reconnect.
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Replying To Messages
You can respond to any message by replying to it. When you have a message open or selected and 
you choose Reply from the Message menu, FirstClass automatically creates a new message with the 
From, Subject, To, and Cc lists filled in. “Re :” is automatically inserted before the original subject. The 
original sender is entered in the field, and copies are sent to anyone who received the original 
message (you may delete names from the To and Cc lists by clicking on the name and pressing the 
Delete button). » You may change the way replies are generated; see the Preferences section for 
details.

Here is an example: Suppose that we had the following message open:

Choosing Reply from the Message menu would create the following new, unsent message:

36



37

Note that both the subject and recipient is filled in. Once you have entered the body of the new 
message, you may send it.

Reply to Sender Only
If you wish to reply only to the author of the original message, select Reply Sender from the Reply 
Special sub-menu (in the Message) menu. No matter how many names were listed in the To, and Cc 
lists of the original message, the reply will be sent only to the original author of the message.  This 
type of addressing is particularity helpful when writing a personal reply.

Forwarding Messages
You may re-send a message to another user using the forward feature.

When you have a message open or selected and you choose Forward from the Message menu, 
FirstClass automatically creates a new message which is a copy of the selected message (including 
attachments) with the From and Subject fields filled in. “Fwd:” is automatically inserted before the 
original subject.
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Here is an example: Suppose that we had the following message open:

Choosing Forward from the Message menu would create the following new, unsent message:

Note that the subject is filled in and the body of the message is duplicated (any file attachments will 
be duplicated as well). Once you have entered the recipients of the new message, you may send it.
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Sending Forms
In addition to supporting standard office-memo style messages, FirstClass also supports electronic 
forms. You can compose and send forms as with normal messages, but the forms may contain fill-in 
fields, checkboxes, popups, etc.. Each FirstClass system includes several standardized forms to 
choose from, including File Transfer, Phone Call, Request For Information, and a Requisition Form.

To send a form, choose New Form from the Message menu, then select the form you wish to send 
from the sub-menu. For example, to send a new phone message form you would choose Phone 
Message from the New Form menu:

 

This would create a new Phone Message form, which you fill in, address and send as you would any 
message:
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Keeping Your MailBox Tidy
To keep your MailBox tidy FirstClass allows you to file messages in folders and to delete unwanted 
messages.

Using Folders
To clean up your MailBox, you might want to organize some of the messages so that you can refer to 
them later on. FirstClass allows you to create folders in your MailBox  for this purpose.
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To create a folder in your MailBox, open your MailBox and choose New Folder from the Conference 
menu. To rename the folder, click on the name and then type in the new name.

You can create multiple folders in your MailBox and also folders within folders. To place messages in 
folders, simply drag them into the folder using the mouse. You can also shift-click to select multiple 
messages and drag all of them into the appropriate folder.

Deleting Messages
If you receive many mail messages, your MailBox can quickly become cluttered. To delete messages 
from your MailBox, select the messages you want deleted (shift-click to select multiple messages) 
and choose Delete from the File menu.

Before actually deleting the messages, FirstClass will ask you to verify that you want to delete the 
selected items. Click Delete to delete selected items, or Cancel to cancel the delete. Regular deletion 
of old messages is recommended in the interests of conserving disk space on the server. You can 
delete folders in exactly the same way you delete messages: highlight the folders and choose Delete 
from the File menu. 
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Message Expiry
All messages in FirstClass have an expiry date, after which they will be automatically deleted. You 
may see the expiry date of a message by selecting or opening the message and then choosing Get 
Info from the File menu. See the Get Info section in the FirstClass Client User Manual for more 
information.
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Conferencing

7
The FirstClass Conferencing feature allows you to exchange ideas and share information  
with other users.
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Understanding Conferences
Conferences are forums or bulletin boards which are generally focused on a single topic. For 
example, there might be a conference that contains items dealing with a particular type of software, or 
a specific product. By reading these conference items, you can stay abreast of information you are 
interested in.

Opening the Conferences icon on the desktop displays the contents of the Conferences Folder. In this 
folder you will find all of the public conferences that are available on your system. There is a second 
type of conference; the private conference. If you have access to any private conferences, their icons 
will also appear; either on your desktop or in a special folder.

♦ Α Νοτε αβουτ αϖαιλαβλε χονφερενχεσ... Τηε σπεχιφιχ λιστ οφ χονφερενχεσ αϖαιλαβλε ον 
ψουρ σψστεμ ωιλλ δεπενδ ον τηε σπεχιαλ ιντερεστ γρουπσ ωιτηιν ψουρ υσερ 
χομμυνιτψ. Ιφ ψου φεελ τηερε ισ α νεεδ φορ α χονφερενχε ψουρ σερϖερ δοεσ νοτ 
ηαϖε, ψουρ Αδμινιστρατορ χαν χρεατε α νεω ονε φορ ψου.

Ιφ ψου αρε ιντερεστεδ ιν α χονφερενχε, οπεν ιτ βψ δουβλε−χλιχκινγ ον ιτσ ιχον. 
ΦιρστΧλασσ σηοωσ ψου ωηιχη χονφερενχεσ χονταιν ιτεμσ τηατ ψου ηαϖε νοτ ψετ ρεαδ βψ 
πυττινγ αν υνρεαδ φλαγ βεσιδε τηε ιχον.

♦ Α Νοτε αβουτ χονφερενχε ινφορματιον... Ιφ ψου αρε χυριουσ αβουτ τηε χοντεντσ οφ α 
σπεχιφιχ χονφερενχε, ψου χαν σελεχτ τηε χονφερενχε ανδ χηοοσε Αβουτ Χονφερενχε... 
φρομ τηε Χονφερενχε μενυ. Τηισ δισπλαψσ α ωινδοω τηατ χονταινσ α βριεφ 
δεσχριπτιον οφ τηε χονφερενχε. Ψου μαψ αλσο δουβλε−χλιχκ ον τηε ναμε οφ α 
χονφερενχε ιν ανψ μεσσαγε το δισπλαψ τηισ ινφορματιον.

Α χονφερενχε χαν βε χονσιδερεδ το βε τηε σαμε ασ α ®πυβλιχ υσερ©. Λικε ανψ υσερ ον 
τηε ΦιρστΧλασσ σψστεμ, τηε χονφερενχε ηασ α ναμε τηατ μαιλ ισ δελιϖερεδ το, ιτ ηασ α 
(τηε χονφερενχε ιχον) ανδ τραχκσ υνρεαδ ιτεμσ.
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Ωηεν ρεαδινγ τηισ σεχτιον ψου ωιλλ νοτιχε τηατ μανψ οφ τηε οπερατιονσ ψου χαν περφορμ 
ωηιλε ιν α χονφερενχε αρε ιδεντιχαλ το τηοσε ωηεν υσινγ μαιλ. Δυε το τηε στρυχτυρε οφ 
τηε ΦιρστΧλασσ σψστεμ, ψου χαν εϖεν δελιϖερ μαιλ το βοτη πριϖατε υσερσ ανδ 
χονφερενχεσ ατ τηε σαμε τιμε.

Ιν γενεραλ, ιφ ψου χαν δο αν οπερατιον ιν τηε ΦιρστΧλασσ μαιλ σψστεμ, ψου χαν μοστ 
λικελψ δο τηε σαμε οπερατιον φρομ τηε ΦιρστΧλασσ χονφερενχε σψστεμ ασ ωελλ.

Browsing Conferences
When you open a conference, a summary of the messages in the conference is displayed.

 

This summary is just like the display in your MailBox. Items that you have not yet read are marked 
with an unread flag ( ) and any that have attachments are marked with an attachment flag ( ).  » 
See the chapter entitled File Attachments and Transfers for more details on attachments.

You may open any message in a conference by double-clicking on it, just as you  can do with 
messages in your MailBox. The message will be displayed on your screen:
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To close the message, just click on the Close Box. You may continue to read messages in the 
conference until you have read all of the unread messages. When there are no more unread 
messages, the Unread Flag beside the conference icon will disappear.

Opening the Next Unread Message
Usually, you will want to read all of  the unread messages in a conference. To make this more 
convenient, FirstClass provides a shortcut to do this: simply open the conference and then choose 
Open Unread from the Conference menu. FirstClass will open the next unread message in the 
conference. Continuing to choose this menu items will read all unread messages. When there are no 
more unread messages, FirstClass will play the System Alert Sound to inform you.

Hint: If you resize the message window, subsequent messages will be opened using that size and 
location.

Since this is a common operation, you might also find it convenient to use either the keyboard 

equivalent (Command-U) or the palette button:   
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Replying To Messages
As you are browsing through a conference, you might see a message that you wish to respond to. 
This is easy to do – you just open or select the message and then choose Reply from the Message 
menu. FirstClass will create a new, unsent message in your MailBox with the From, Subject, and To 
fields filled in appropriately.

For example, you had the message above open and you chose Reply from the Message menu the 
following message would be created. Note that the From, Subject, and To fields are filled in:

You then click in the body of the message and enter your reply. When you send the message, it is 
delivered to the conference.
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Replying To The Sender of a Message
When you are in a conference and you choose Reply, the To: list of the reply normally contains the 
name of the conference you are in. If you want to reply to the sender of the message rather than the 
conference, choose Reply Sender from the Reply Special sub-menu (in the Message menu).

Following Message Threads
As users discuss various topics in a conference, the original message and the set of replies creates a 
thread of messages on a particular topic. For example, in the following conference there are several 
messages all on the topic of “My CD Adapter”:

Next In Thread
If you open the initial message (e.g. the one from Colin Biggin) and then choose Next in Thread from 
the Conference menu, FirstClass will open the next message in the thread, in this case the message 
from Colin Welch. Choosing Next in Thread again will open then next message (from Colin Welch), 
and choosing it again will open the message from Jane. If you choose Next in Thread again and there 
are no more messages in the thread, FirstClass will notify with a beep.

Since this is a common operation, you might also find it convenient to use either the keyboard 

equivalent (Command-/) or the palette button:   
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Previous In Thread
The threading feature will also work in reverse, to take you to the previous message in the thread. 
This is especially useful when you read a message in the middle of a thread, but the message does 
not have enough information to give you the context.

In the example above, suppose you opened the last message in the thread, from Jane Jazrawy. To 
open the previous message in the thread, just hold down the Option key before pulling down the 
Conference menu and choosing Next in Thread. 

Since this is a common operation, you might also find it convenient to use either the keyboard 

equivalent (Command-Option-/) or the palette button:   

Sending Messages To Conferences
To send a new message to a conference, simply open the conference and choose New from the 
Message menu. A new, unsent message will be created in your MailBox, with the To name already 
filled in with the conference name.

For example, if you opened the “Customer Support” conference and chose New, the following unsent 
message would open on your screen:
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After you have entered the subject and the body of the message, you send the message and it will be 
delivered to the conference (in this case “Customer Support”):

Forwarding Messages
Just as you may forward private mail to other users, you may forward conference messages to other 
users or conferences. Simply open or select the message you want to forward and then choose 
Forward from the Message menu. FirstClass will duplicate the contents of the message, including 
attachments.

The new message has the same content as the original but, other than the subject name, has an 
empty envelope. After you fill in the envelope information you may edit the body text and then send it.
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Subscribing to a Conference
If you use a particular conference frequently you may wish to subscribe to it. You subscribe to a 
conference by placing an alias of the conference onto your desktop. Subscribing to a conference is a 
simple way of keeping a watch on the conferences that are of the most interest to you. Instead of 
navigating through various conferences and sub-conferences, you can just double-click on the 
conference alias on your desktop.

Also, if there are unread items in the conference, the unread flag is displayed next to the alias, which 
makes it easier to find new items. Rather than having to go and look at each conference individually, 
by subscribing you will be able to tell at a glance which conferences have new messages.  

To make an alias to a conference, click on the conference and then choose Make Alias from the 
Conference menu.

Here is an example: The “Customer Support” conference on the Veritec BBS system is in the 
“Conferences” folder. If you are interested in the “Customer Support” conference, it is much more 
convenient to have an alias of the conference right on your Desktop than to have to manually open 
layers of conferences. To do this, click on the “Customer Support” conference and then choose Make 
Alias from the Conference menu. An alias of the conference will appear on your Desktop:

In this example, the conference has an unread flag to indicate that the conference contains some new 
items. You may also delete an alias from your Desktop by selecting the alias and choosing Delete 
from the File menu.
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Attachments and File Transfers

8
With FirstClass, you may use file attachments for transferring and sharing files between 
users.
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Sharing Files Using FirstClass
FirstClass provides a convenient and powerful method of file transfer by allowing you at attach files to 
messages. When you send the message, the recipient is able to save the attachments onto their own 
computer.

Since you are using FirstClass to transfer the files, there is no need to worry about the type of file you 
are transferring or what type of protocol is being used – you just attach the file. FirstClass file 
transfers work just the same whether you are connected over a modem or a network, and they even 
work if the recipient is on another type of computer (e.g. Windows).

Background File Transfers
Attaching a file to a message or saving an attachment involves a file transfer either from or to the 
FirstClass Server. To make the system more convenient, FirstClass performs all file transfers in the 
background. This means that even while a file transfer is in progress, you may continue to use all 
features of FirstClass, even if you are connected over a modem.

Reading Messages With Attachments
If a message has any attached files an attachment icon ( ) will be displayed beside the message in 
the summary list and an Attachments list appears in the envelope. For example, the “Customer 
Support” conference might have the following message in it. Note that there are two files attached to 
the message:
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To save an attachment on your Macintosh, double-click on the attachment. A dialog will come up and 
allow you to choose the destination folder and filename on your Macintosh. Click Save and the file 
transfer from the server to your computer will begin..

The File Transfer Progress window displays the status of the file transfer. When the transfer is 
complete, this window disappears. (Note that you can move this window by dragging it). Closing this 
window will cancel the file transfer. Remember, you may continue to perform any operation in 
FirstClass even while the file transfer is in progress.

Sending Messages With Attachments
When you are editing an unsent message, you may attach a file by choosing Attach File... from the 
File menu. A dialog appears, allowing you to select the file you wish to attach. Select the file you want 
and click the Save button. The file will be sent to the FirstClass server and attached to your message. 
While the file is being sent to the server, the File Transfer Progress window shows you the status of 
the transfer. The file attached will be included in the list of Attachments on your message. You can 
attach as many files as needed.
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